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t’s difficult to see the bottom line in a flat list
ike this, turning the list into a Pivot Table will
nelp.

A B E ¥ E F G
Jan-07 Joseph MNorth FastCar 8 1,592 563
lan-07  Joseph MNorth RapidZoo 8 1,088 397
Jan-07  Joseph West SuperGlue 8 1,680 753
Jan-07 Joseph West FastCar 9 2,133 923
Jan-07  Joseph West RapidZoo 10 1,610 579
Jan-07  Joseph Middle SuperGlue 10 1,540 570
Jlan-07  Joseph Middle FastCar 7 1,316 478
Jan-07  Joseph Middle RapidZoo 7 1,799 709
Jan-07 Lawrence  Morth SuperGlue 8 1,624 621
Jan-07 Lawrence  Morth FastCar & 726 236
Jan-07 Lawrence  MNorth RapidZoo 9 2,277 966
Jam-07 Lawrence  West SuperGlue 6 714 221
Jan-07 Lawrence West FastCar 9 2,682 1,023
Jan-07 Lawrence  West RapidZoo 6 1,500 634
Jan-07  Lawrence  Middle SuperGlue 7 917 403
Jan-07 Lawrence  Middle FastCar 7 1,939 760
Jan-07  Lawrence  Middle RapidZoo 6 984 314
Jan-07  Maria North SuperGlue 9 981 372
Jlan-07 Maria North FastCar 10 1,520 a76
Jan-07  Maria North RapidZoo 6 966 330
Jlan-07 Maria West SuperiGlue 10 2,800 903
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Pivot Tables

e So far we have been summarizing (filtering)
data using IF statements.

e Pivot tables are a much more powerful,
“interactive” way to produce summaries.

— Can summarize information from selected fields of
a data source.

— Pivot: rows can easily become columns, columns
can easily become rows.



Examples

Summarizing data, i.e. finding average sales
for each region for each product

Filtering, sorting, summarizing data without
writing any formulas

Transposing data
Linking data sources



Organize your Data

e Must be raw data, unprocessed and
unsummarizec

e Fach column should have a header.

e The data should have no blank rows or

columns
_Middle North West Grand Total

Joseph 5 148,067.00 $ 139,014.00 S145,526.00 $ 432,607.00
Vrence 5 141,498.00 S 151,339.00 A g c D £ £ G
5 142,013.00 S 138,118.00
5 141,224.00 S 139,249.00 Jan-07 Joseph North FastCar 8 1,592 563
Jan-07 Joseph Morth RapidZoo 8 1,088 397
s 372,802.00 s 567,720.00 Jan-07  Joseph West SuperGlue 1,680 753
/ Jan-07 Joseph West FastCar 2,133 923
Jan-07  Joseph West RapidZoo 1,610 579
Jan-07  Joseph Middle Suf 1,540 570
no t raw d ata , Jan-07  Joseph Middle FastCa 1,316 428
. Jan-07 Joseph Middle RapidZoo T 1,799 709
alread y summarize d Jan-07 Lawrence Morth SuperGlue B 1,624 621
lan-07 Lawrence MNorth FastCar [ 726 236
Jan-07 Lawrence Morth RapidZoo 9 2,277 966
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Pivot Table Setup

* To create a pivot table, specify:
— Which fields you’re interested in
— How you want the table organized
— What kinds of calculations you want to perform

e You can:

— Rearrange it to view from alternative perspectives

e “pivot” the dimensions —i.e. transpose column
headings to row positions



Creating Pivot Tables

e Click on a cell from the table you want to
summarize.

e From the Insert tab, click the PivotTable icon
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Creating Pivot Tables

e Select the range you want to summarize and
where you would like the pivot table to
appear.

Create PivotTable | D -

Choose the data that you want to analyze
@ Select a table or range
3
Use
Choose where you want the PivotTable report to be placed
Mew Worksheet
Existing Worksheet
Location: Bz
Ok ] | Cancel




Creating a Pivot table

PivotTable Fields vx

* The PivotTable Field list is e CE
divided into sections.
* You can drag and drop the S

Profit / Loss

fields you want in each area. o

* The body of the table will
contain three parts: Rows,
Columns and Cells. You can
use any fields in these areas.

ROWS VALLUES

Defer Layout Update



PivotTable Fields v X

Choose fields to add to report: L * B

[ ] Month

[ salesman
Region
Product

[ Me. Custemers
Met Sales

[] Profit / Loss

Average of Net Sales Column Labels |E|

MORE TABLES... Row Labels '~ Middle North West Grand Total
FastCar 5 1,582.69 S 1,651.58 $ 1,621.86 5 1,618.71
RapidZoo 5 1,570.33 S 1,541.56 S 1,571.69 5 1,561.19

Drag fields between areas below: SuperGlue 5 1,620.33 5 1,550.78 S5 1,583.04 S5 1,586.48
Grand Total 5 1,591.12 § 1,581.39 $ 1,503.86 5 1,583.80

Y FILTERS Il COLUMMS

| Region -
= ROWS E VALUES
Product - | |Averageu:uf Me.. ™

[ | Defer Layout Update
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PIVOTTAEBLE TOOLS
AMALYZE

PivotTable Fields v X = =====

Design Tab under
PivotTable Tools.

You can add
subtotals, from the

Choose fields to add to report: 2 *
L] Month Sum of Net Sales Column Labels | ~ |
Salesman Row Labels  ~ FastCar RapidZoo SuperGlue  Grand Total
Region - Middle /
Product Joseph $  48,180.00 S 49,9890 S 49,898.00 S 148,067.00
:;';:ime“ Lawrence 5 49,858.00 $ 4570700 S 45937.00 $ 141,498.00
O] broit/ Loss Maria 5 50,023.00 $ 43,175.00 $ 48,855.00 $ 142,013.00
Matt 5 41,862.00 S 49WA2.00 S 49,750.00 S 141,224.00
MORE TABLES... iddle Total 5 189,923.00 5188,439.00 $194,440.00 $ 572,802.00
=INorth
Joseph 5 48,185.00 & 46494.00 S 44,335.00 $ 139,014.00
Drag fields between areas below: Lawrence 5 47, 796.00 5 52,030.00 5 51,513.00 5 151,339.00
Maria 5 51,545.00 $ 43,497.00 $ 43,076.00 $ 138,118.00
ll COLUMMNS Matt $  50,664.00 $ 42,956.00 S 45,619.00 $ 139,249.00
Order Matters!  |{j=sspm - North Total §  108,100.00 $184,087.00 $184,543.00 $ 567,720.00
—'West
Joseph 5 52,467.00 § 47,118.00 $ 4594100 S 145,526.00
= nevs > VALUES Lawrence 5 A4,870.00 S 48,738.00 S 44,046.00 S 137,654.00
Region | Som o Net S0 | Maria 5 46,676.00 $ 43,636.00 $ 49,111.00 $ 139,423.00
Salesman = Matt 5 50,610.00 $ 49,111.00 $ 51,467.00 $ 151,188.00
est Total ¢  104,623.00 $188,603.00 $190,565.00 $ 573,791.00
rand Total §  582,736.00 $562,029.00 $569,548.00 $1,714,313.00

Click the down

[ | Defer Layout Update arrow to change

field settings and
formatting
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Same data, different story
 The data is the same, only the perspective is

different

Average of Net Sales Column Labels | -

Row Labels - Middle North West Grand Total
FastCar 5 1,582.69 5 1,651.58 S 1,621.86 S 1,618.71
RapidZoo g 1,570.33 % 154156 & 1,571.69 & 1,561.19
SuperGlue S 1,620.33 $ 1,550.78 $ 1,588.04 $ 1,586.48
Grand Total 5 1,5901.12 § 1,581.30 § 1,593.86 § 1,583.80

CS1100

Sum of Net Sales Column Labels -

d |

Row Labels - | FastCar RapidZoo SuperGlue  Grand Total
= Middle
Joseph g 48,180.00 S 49,989.00 $ 49,893.00 $ 148,067.00
Lawrence 5 49,858.00 $ 45,703.00 5 45937.00 $ 141,498.00
Maria g 50,023.00 $ 43,135.00 $ 48,855.00 $ 142,013.00
Matt 5 41,862.00 $ 49,612.00 5 49,750.00 S 141,224.00
Middle Total $ 18002300 $188,430.00 $194,440.00 $ 572,802.00
=INorth
Joseph g 48,185.00 S 46,494.00 $ 44,335.00 $ 139,014.00
Lawrence 5 47,796.00 $ 52,030.00 5 51,513.00 $ 151,335.00
Maria g 51,545.00 $ 43,497.00 $ 43,076.00 $ 138,118.00
Matt 5 50,664.00 $ 42,966.00 5 45,619.00 $ 139,245.00
North Total $  108,190.00 $184,087.00 $184,543.00 $ 567,720.00
=IWest
Joseph g 52,467.00 S 47,118.00 $ 45941.00 $ 145,526.00
Lawrence 5 44,870.00 $ 48,738.00 5 44,046.00 S 137,654.00
Maria g 46,676.00 S 43,636.00 $ 49,111.00 $ 139,423.00
Matt 5 50,610.00 $ 49,111.00 5 51,467.00 $ 151,188.00
West Total $  104,623.00 $188,603.00 $190,565.00 $ 573,791.00
Grand Total 5 582,736.00 5562,029.00 $569,548.00 $1,714,313.00
Pivot tables and charts 13 S v oYt



Add a Filter

Sum of Net Sales Column Labels ~

Row Labels |~ |FastCar RapidZoo SuperGlue  Grand Total Row Labels RapidZoo  SuperGlue Grand Total
= Middle = Middle
Joseph ) 48,180.00 $ 49,989.00 $ 49,898.00 $ 148,067.00 Joseph S 1,316.00 S 2,079.00 5 1,434.00 $ 4,829.00
Lawrence ] 49,858.00 $ 45,703.00 $ 45937.00 $ 141,498.00 Lawrence 5 714.00 5 1,660.00 $ 1,296.00 $ 3,670.00
Maria g 50,023.00 & 43,135.00 $ 48,855.00 & 142,013.00 Maria S 1,666.00 S 1,611.00 5 1,575.00 §$ 4,852.00
Matt 5 41,862.00 S 49,612.00 S 49,750.00 5 141,224.00 Matt s 1,015.00 $ 945.00 5 2,097.00 $ 4,057.00
Middle Total $  189,923.00 $188,439.00 $194,440.00 $ 572,802.00  Middle Total $ 4,711.00 5 6,295.00 $ 6,402.00 517,408.00
- North = North
Joseph $  48,185.00 $ 46,494.00 $ 44,335.00 $ 139,014.00 Joseph 5 960.00 $ 1,125.00 5 1,968.00 $ 4,053.00
lawrence ~ $  47,796.00 $ 52,030.00 $ 51,513.00 $ 151,339.00 Lawrence 5 2,930.00 $ 1,8%0.00 $ 1450.00 $ 6,310.00
Maria $  51,545.00 $ 43,497.00 $ 43,076.00 $ 138,118.00 Maria s 151000 $ 1,656.00 S 1672.00 $ 4,838.00
Matt $  50,664.00 $ 42,966.00 $ 45,619.00 $ 139,249.00 Matt 5 2,628.00 5 1,600.00 $ 1,584.00 $ 5,812.00
North Total §  198,100.00 $184,987.00 $184,543.00 § 567,720.00 NorthTotal § 802800 $ 627100 $ 6714.00 $21,013.00
“I'West “'West
Joseph $  52,467.00 $ 47,118.00 & 45941.00 $ 145,526.00 Joseph 2,088.00 $ 1,02000 S 1,602.00 $ 4,710.00
Lawrence  $  44,870.00 $ 48,738.00 $ 44,046.00 $ 137,654.00 Lawrence 1,071.00 861.00 S 2,020.00 $ 4,012.00
Maria $ 46,676.00 $ 43,636.00 S 49,111.00 $ 139,423.00 Maria 928.00 5 1,698.00 5 1656.00 $ 4,282.00
Matt $  50,610.00 $ 49,111.00 $ 51,467.00 $ 151,188.00 Matt 1,590.00 $ 2,660.00 $ 1,512.00 $ 5,762.00
West Total §  194,623.00 $188,603.00 $190,565.00 § 573,791.00  vestTotal 5,677.00 $ 6,239.00 3 6,850.00 $18,766.00
Grand Total §  582,736.00 $562,029.00 $560,548.00 $1,714,313.00  CrandTotal 13,416.00 $18,305.00 $19,966.00 $57,187.00
University
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Working with Dates

e Often, there are many dates in a data set

e Excel lets us group data items together by day,
week, month, year...



Working with Dates

Sum of Net Sales Column Labels -

Row Labels - Jan-07 Feb-07 Mar-07 Apr-07 May-07 Jun-07
- Joseph 5 12,758.00 514,098.00 $12,602.00 5$13,847.00 $17,063.00 $516,188.00
FastCar 5 5,041.00 S 4,347.00 S 4,376.00 S 4,044.00 5 3,143.00 S 5,586.00
RapidZoo 5 4,497.00 S 4,233.00 5 4,193.00 S 3,848.00 S 6,483.00 S 5473.00
superGlue  § 3,220.00 $ 5,518.00 $ 4,123.00 $ 5,955.00 $ 7,432.00 $ 5,124.00
=ILawrence 5 13,363.00 513,384.00 $14,649.00 $17,050.00 $16,401.00 515,969.00
FastCar 5 5,347.00 S 6,124.00 S 3,999.00 S 5,332.00 5 5,340.00 S 3,774.00
RapidZoo 5 4,761.00 S 3,147.00 5 6,540.00 S5 6,994.00 S 4,408.00 S 5,170.00
superGlue  § 3,255.00 $ 4,113.00 $ 4,110.00 $ 4,724.00 $ 6,653.00 $ 7,025.00
=IMaria 5 15,199.00 513,909.00 $12,733.00 515,288.00 $14,182.00 $16,725.00
FastCar 5 4,866.00 S 5,109.00 S 4,410.00 S 4,990.00 5 6,007.00 S 7,260.00
RapidZoo 5 4,005.00 S 3,668.00 S 3,585.00 S 5,282.00 S 3,447.00 S 5,317.00
superGlue  § 6,328.00 $ 5,132.00 $ 4,738.00 $ 5,016.00 $ 4,728.00 $ 4,148.00
=IMatt 5 15,566.00 %16,493.00 $11,547.00 5$13,5906.00 $14,847.00 513,475.00
FastCar 5 4,093.00 S 6,087.00 S 3,414.00 S 5185.00 5 4,592.00 5 4,993.00
RapidZoo 5 5,714.00 S 4,959.00 5 4,060.00 5 4,006.00 S 5,822.00 S 4,789.00
superGlue  § 5,759.00 $ 5,447.00 5 4,073.00 $ 4,405.00 $ 4,433.00 $ 3,688.00
] Grand Total 5 L6,886.00 557,884.00 $51,621.00 $59,781.00 $62,493.00 $62,357.00
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Row Labels
=/Joseph
FastCar
RapidZoo
SuperGlue
= Lawrence
FastCar
RapidZoo
SuperGlue
=IMaria
FastCar
RapidZoo
SuperGlue
=/Matt
FastCar
RapidZoo
SuperGlue
Grand Total

CS1100

Working with Dates

Jlan- ?I Feh-07
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12,758.0v% Lopy
5,041.01 Format Cells...

4,497.01 B Refresh

3,220.01
13,363.00 2o
5,347.01 Filter

4,761.00 . syptotal "Month"

3,235.00
Expand/Collapse

15,199.01
4,866. -

4,005.00 @8 Ungroup...
6,328.01
15,566.0!
4,093.0
5,714.0( [ Field Settings...

5,759.01
26,880.00 ] | Hide Field List

Move

Pivot tables and charts

X Remove "Month”

PivotTable Options...
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Row Labels
=/Joseph
FastCar
RapidZoo
SuperGlue
= Lawrence
FastCar
RapidZoo
SuperGlue
=IMaria
FastCar
RapidZoo
SuperGlue
=/Matt
FastCar
RapidZoo
SuperGlue
Grand Total

CS1100

Working with Dates
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12,758.0v% Lopy
5,041.01 Format Cells...

Mar-07

Sor Group sales by year

4,497.01 & Refresh
3,220.01

13,363.00
5,347.01 Filter

4,761.00 Subtotal "Month”
3,235.00
Expand/Collapse k

15,199.01
4,866. -

4,005.00 B8 Ungroup...
6,328.0
15,566.00

4,093.01
5,714.01 |__'.|§|. Field Settings...

5,759.01 PivotTable Options...
26,886.00 ] | Hide Field List

Move »

X Remove "Month"

Pivot tables and charts

: Grouping @

| Awuto

| By

Starting at | 1/1/2007
Ending at: | 5/2/2009

Seconds -
Minutes

Hours

Days

Months

Euarters

-

MNumber of days: |1

[ 0K ]’ Cancel ]
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Working with Dates

Sum of Met Sales Column Labels ~

Row Labels

- Joseph
FastCar
RapidZoo
SuperGlue

=lLawrence
FastCar
RapidZoo
SuperGlue

='Maria
FastCar
RapidZoo
SuperGlue

=IMatt
FastCar
RapidZoo
SuperGlue

Grand Total

- | 2007

$

S
$
S
$
S
$
S
$
S
$
S
$
S
$
S
$

174,229.00
56,001.00
60, 766.00
57,462.00

179,911.00
57,629.00
60,734.00
61,545.00

172,488.00
61,752.00
53,177.00
57,559.00

173,261.00
56,698.00
56,738.00
59,925.00

690,989.00

Pivot tables and charts

2008

$175,739.00
$ 62,652.00
5 57,395.00
§ 55,692.00
%165,670.00
$ 55,463.00
5 56,766.00
$ 53,441.00
$162,000.00
$ 58,400.00
5 48,319.00
§ 55,281.00
%168,290.00
5 56,668.00
5 56,119.00
$ 55,503.00
$671,699.00

R ¥ S W S e S e e i ¥ S ¥ S T ¥ S W S Wy S ®

:

82,630.00
30,179.00
25,440.00
27,020.00
£4,910.00
29,432.00
28,971.00
26,507.00
85,066.00
28,092.00
28,772.00
28,202.00
90,010.00
29,770.00
28,832.00
31,408.00

$342,625.00

R ¥ S W S o T O S e " ¥ O ¥ ¥ SR % i W S s W R e

Grand Total

432,607.00
148,832.00
143,601.00
140,174.00
430,491.00
142,524.00
146,471.00
141,456.00
419,554.00
148,244.00
130,268.00
141,042.00
431,661.00
143,136.00
141,689.00
146,836.00

1,714,313.00




Slicers

* |tis not easy to see the current filtering state
when you filter on multiple items

* Slicers are easy-to-use filtering components with
buttons that enable you to quickly filter the data
in a PivotTable, without opening drop-down lists
to find the items that you want to filter.

* |n addition to quick filtering, slicers also indicate
the current filtering state, which makes it easy to
understand what exactly is shown in a filtered
PivotTable report.



Slicers

o Slicers allow us to quickly filter the table to show
only the North region and the RapidZoo product for
all Salesmen

Salesman Region )4
Sum of Net Sales Column Labels T ) h
. ose -
Row Labels -T RapidZoo Grand Total P Middle
=INorth 5 184,987.00 4%184,987.00 Lawrence North
Joseph 46,494.00 5 46,494.00 .
Maria Waest

5

Lawrence 5 52,030.00 S 52,030.00

Maria g 43,497.00 $ 43,497.00 Matt
5
$

Matt 42,966.00 5 42,966.00
Grand Total 184,987.00 5184,987.00
Product )&
FastCar
RapidZoo
SuperGlue
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Multiple Summary
Functions
PivotTable Fields ¥ % to the Same Fleld

Choose fields to add to report: -
Column Labels -
Month FastCar RapidZoo
V| Salesman Row Labels ~ Average of Net Sales Sum of Net Sales Average of Net Sales Sum of Net Sales
¥l Region - Middle g 1,582.60 §  189,023.00 $ 1,570.33 §  188,439.00
vl Product Joseph 5§ 1,606.00 & 48,180.00 S 1,666.30 S 49,989.00
Mo. Customers Lawrence $ 1,661.93 $  49,858.00 & 1,523.43 $  45,702.00
v Net Sales )
Drafit / Loce Maria g 1,667.43 & 50,023.00 S 1,437.83 & 43,135.00
' Matt g 1,395.40 & 41,862.00 % 1,653.73 & 49,612.00
MORE TABLES... = North 5 1,651.58 $  198,190.00 $ 1,541.56 %  184,987.00
Joseph & 1,606.17 & 48,185.00 % 1,549.80 & 46,494.00
Lawrence S 1,593.20 & 47,796.00 S 1,734.33  § 52,030.00
Drag fields between areas below: Maria g 1,718.17 & 51,545.00 % 1,449.90 & 43,497.00
Matt g 1,688.80 & 50,664.00 S 1,432.20 & 42,966.00
FILTERS COLUMNS - West g 1,621.86 §  194,623.00 $ 1,571.69 $  188,603.00
Product M Joseph 5§ 1,748.90 & 52,467.00 S 1,570.60 % 47,118.00
¥ Values v Lawrence 1,495.67 & 44,870.00 & 1,624.60 S 48,738.00
Maria g 1,555.87 & 46,676.00 S 1,454.53 &% 43,636.00
ROWS Matt g 1,687.00 & 50,610.00 & 1,637.03 & 49,111.00
Region « Y verage of e, Grand Total  § 1,618.71 $  582,736.00 $ 1,561.19 $  562,029.00
Salesman - Sum of Met Sa...

\ Drag another copy of the field into the Values box.

Defer Layout Update
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Calculated Fields

In a pivot table, you can create a new field that
performs a calculation on the sum of other pivot

fields.

For example, we can create a calculated field
named Bonus to calculate 3% of the Total Net
Sales as a bonus for each salesperson.



Calculate a Bonus for each Salesperson

Row Labels |~ Sum
Joseph 3
Lawrence 3
Maria 3
Matt 3
Grand Total 3
CS1100

of Net Sales
432,607.00 1!
430,491.00
419,554.00
431,661.00

1,714,213.00

Insert Calculated Field

MName: Eonus

Formula: |= 'Met Sales'*0.03|

Fields:

Month
Salesman
Region
Product

Mo, Customers

Profit / Loss

Insert Figld

oK ] [ Close

Pivot tables and charts

Joseph
Lawrence
Maria

Matt

Grand Total

24

432,607.00
430,491.00
419,554.00
431,661.00
1,714,313.00
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About Calculated Fields

For calculated fields, the individual amounts in
the other fields are summed, and then the
calculation is performed on the total amount.

Calculated field formulas cannot refer to the
Pivot table totals or subtotals

Calculated field formulas cannot refer to
worksheet cells by address or by name.

Sum is the only function available for a
calculated field.



To add a calculated field:

e Select acell in the pivot table, and on the PVGTTABLE TOOLS
Excel Ribbon, under the PivotTable Tools tab, »  awwze  pesion
click the Analyze tab. ECIEW i
* Inthe Calculations group, click Fields, Items S
& Sets, and then click Calculated Field. actions Calculations

(Calculated fields can also be modified here.)

 Type a name for the calculated field, for example,
Bonus.

* |Inthe Formula box, type in the formula

e Click Add to save the calculated field, and click Close.
The Bonus field appears in the Values area of the pivot
table, and in the field list in the PivotTable Field List.



Calculated Items

e A calculated item is a new item in an existing field
e Derived from calculations performed on other items already in the field.

e Example: the service plan for FastCar adds 5% to sales for the product.
Create a new Calculated Item that calculates values for FastCar service
plans.

Row Labels | Sum of Net Sales
=IMiddle 4582,208,15
FastCar 5189,923.00
RapidZoo 5188,439.00
| superGlue | $194,440.00
adjustedFastcar $9,496.15
=INorth $577,620.50
FastCar $198,190.00 Insert Calculated Item in "Product” l 7 S
RapidZoo 5184,987.00
SuperGlue $184,543.00| | pame: | SEEEEEEE—— =]
adjustedFastcar 59,909.50
' Formula: | =FastCar *0.05 Delete
Swest §583,522.15}
FastCar 5194,623.00
RapidZoo $188,603.00 E'E'd“"; Lo
Mo - FastCar -
SuperGlue 5190,565.00| | |zzlesman RapidZoo
adjustedFastcar L L | S | |xnd
1 adjustedFastcar
Grand Total $1,743,449.80 | | 0. Customers
Met Sales
Profit / Loss
0K ] l Close
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Calculated Items Warnings

A field with a calculated item cannot be moved to the
Report Filter area

Multiple copies of a field are not supported when a PT
has calculated items.

A problem can occur when a calculated item or
function defined in one pivot table is applied to other
pivot tables in an Excel file causing a conflict.

This can be solved by making pivot tables that are
based on the same source data independent.

— For instance, give the source data two different defined
names and use one of the names for a PT with a
calculated item and the other name for pivot tables
without.



Pivot Charts

You can also make charts of summarized pivot
table data. PIVOTTABLE TOOLS

AMALYZE DESIGM

Clear = (7 Fields, tems, & Sets ~
Select - fu OLAP Tools

I [ |
. PivotChart
Move PivotTable  BF Relationships

Artinme Talrnlatimnc

Sum of Net Sales Column Labels E
Row Labels |E| FastCar RapidZoo SuperGlue  adjustedFastcar
Joseph 5 148,832.00 5143,601.00 5140,174.00 5 7,441.60
Lawrence 5 142,524.00 5146471.00 5141,496.00 5 7,126.20
Maria 5 148,244.00 5130,268.00 5$141,042.00 5 7,412.20
Matt 5 143,136.00 5141,689.00 $146,836.00 5 7,156.80
Sum of Net 5ales l
5160,000.00
5140,000.00 l
5120,000.00
Product =
5100,000.00 u FastCar
580,000.00 = RapidZoo
560,000.00 m SuperGlue
540,000.00 m adjustedFastcar
520,000.00
5_
Joseph Lawrence Maria
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Create a Pivot Table from an Access Table

From the Data Menu, choose “From Access”

HOME INSERT PAGE LAYOUT FORMULAS DATA

-EI- [E DE)_ D IIZE =] Connections |

From From Other Existing Refresh z
Text Sources+  Connections All -

Get External Data Connections
Select Table 7 &

. . Mame Description  Modified Created Type
Find your Access file B OrderInfo 4122012 8:08:51PM  4/12/2012 8:08:51PM  VIEW
EH Contacts 10/27/2010 9:45:31 AM  10/20/2008 9:57:08 AM  TABLE

and choose the table or B contac 271 20/
Line Ttems 10/2/2010 3:11:44 M 10/20/2008 10:19:37 AM  TABLE
query to use in your [ Orders 10/20/2008 10:39:43 AM  5/56/1994 12:58:54PM  TABLE
; Products 10/2/2010 3:12:24PM  6/5/1994 12:58:58 FM  TABLE
pIVOt table. ZipCodes 10/27/2010 9:45:46 AM  10/20/2008 9:55:41 AM  TABLE
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Any Questions?
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